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I. Introduction
WebBoard is a conferencing system that can be
accessed over the Internet by any computer, using a
Web-browser.

At UIC, WebBoard is used for conferences and for
conducting classes over the Web. Every course is
run on a virtual board enabling students and
instructors to interact as a group privately. Access is
restricted to registered users of that particular
course. Every board can have many conferences
running concurrently and the instructor maintains the
access rights of students to conferences. The
instructor of a course is the manager of that
conference board. As a user, you can post new
topics, reply to messages within a topic, and also
reply privately to the sender of a message via
normal email. WebBoard also has a live chat
feature.

This document provides a brief introduction to the
basics of WebBoard 3.0. More detailed information
about any aspect of WebBoard can be found in the
online help (see Section IV: Working with WebBoard).

II. On to WebBoard
To access WebBoard, you need a computer with a
World Wide Web browser application that has
JavaScript support, preferably Netscape Navigator
3.0 or Internet Explorer 3.0 or higher. You can use
the computers in the public ADN computer labs. In
order to take full advantage of WebBoard, turn on
the “frames” option in your browser. You also need
to have cookies and JavaScript enabled to access
WebBoard. This is done in Netscape via
Edit→Preferences→Advanced, and in Internet
Explorer via View→Internet Options→Advanced &
Security. Note that the AOL internal browser does
not work! Use Netscape instead.

The URL (i.e. Web address) for accessing your
board will be of the form

http://webboard.uic.edu:8080/~coursename
where the coursename is as listed in the timetable,
all in lowercase, without spaces. For a MATH101
class, the URL would thus be

http://webboard.uic.edu:8080/~math101
Access may also be provided through the webpage
of your course (via a button to click).

The steps involved in accessing WebBoard are:

• Start your browser by double clicking on its icon.

• Enter the URL for your WebBoard site in the
Address or Location bar at the top of the
window and hit Enter.

• The log-in window will appear:

If it does not appear because you typed an invalid
address, you will be presented with a list of valid
boards to choose from. You will be able to
successfully log in only to your class's board.
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III. Logging In
Every user of the WebBoard system has an
individual login and password. Once you are
connected to the system, a login window will
appear. 

Your WebBoard user name is the same as your UIC
netID (i.e. the login ID you use to log in to icarus or
tigger). Your instructor will tell you what your initial
WebBoard password is. It is strongly recommended
that you change it the first time you log into
WebBoard. Refer to Section V for more information
on changing your password.

Use the following steps to log in:

• In the field labeled User Name, enter your netID.

• Navigate to the Password field using either the
mouse or the Tab key and enter your password.

• Click OK or press Enter.

• Once inside, the Welcome screen of your class
WebBoard will look like:

IV. Working with WebBoard
Before you start using WebBoard, you need to
become familiar with the navigational aids.

The Menubar:

The following section describes each of the
functions you can perform with the eight menu
buttons:

 Post a new topic or message to the
conference (a conference should be selected before
doing this). A topic form will appear for you to fill in.
The message posted appears as the first message
in the new topic.

 Updates your conferences list to indicate
any new activity. A new message or reply posted will
not show up in the Conference Menu unless it is
refreshed.

 Displays the list of available chat rooms
and the number of active users. Clicking on the
name of a conference chat room opens it, allowing
you to carry on real-time interactive discussion with
other conference users.

 Opens the Message Search form, which
you can use to find specific content in one or more
messages and/or topics.

 Opens up the Mark Messages Read
menu. Mark Messages Read allows you to mark
messages read in one or all conferences. To mark
all messages read in a single conference, click a
conference. To mark all messages read in all
conferences, click "Mark All Conferences Read".
Marking messages as read eliminates the -icon
and the italics from new messages. WebBoard does
not automatically update a message you have read;
you must do it manually, using this button.

 Opens the More Options menu. The
available options are:

Edit your Profile

Opens your personal profile. See Section V.

Email Notify

Notifies you by Email when there is a new
message in a particular conference.

Mailing Lists

Lets you subscribe to a mailing list associated
with a conference, if your board manager
decided to create one. This is for receiving
copies of WebBoard messages in your private
email.

Current Users

Lists the users logged in to WebBoard right now,
with the login time, users’ location, and a
hyperlink to their profile.

Today's Users

Lists the users who have logged in to WebBoard
today, with the time, users' location, and a
hyperlink to their profile.



3

Search Users

Opens a search form to locate users by their first
or last name or by the first letter of their first
name.

Top 10 Users

Lists the top 10 WebBoard users (by accesses)
with a link to their profile and the total number of
times they have logged in.

Top 10 Posters

Lists the top 10 WebBoard message/topic
posters with a hyperlink to their profile and the
total number of their postings.

New Messages

Lists all your unread messages, with the
conference, subject, date, time, and a hyperlink
to each message, sorted by time and date.

Today’s Messages

Lists the messages posted today, with the
conference, subject, time, and a hyperlink to
each message, be they read or not.

Conference Profiles

Displays a description of all conferences in your
board. Clicking on one shows activity statistics
within that conference.

List Boards

Lists all boards you have previously accessed
for quicker navigation. Normally there is only
one board listed.

Login as a Different User

Tells you how to log in as a different user. You
need to either use a second browser program or
quit and restart your browser.

 Opens the WebBoard Help Index. It
provides user help on the commands and features of
WebBoard. To search in this long table of contents,
use your browser’s Find command (Control-F).

 This button takes you out of WebBoard,
usually to your class homepage or to the UIC
homepage. Although it says LOGOFF, it does not
log you off. You can use the browser’s back button
to continue working in WebBoard. To actually log
out, you have to quit your browser! Always do that
when you are done in WebBoard, or others could
manipulate/destroy your data!

Browsing Conferences

The Conferences menu displays the conferences,
topics and messages of a particular board in a
hierarchical list. In a frames-enabled browser, the list
appears on the left side of the screen.

The Conferences Menu

All the conferences in the board are displayed in the
Conferences Menu. The information in WebBoard
is set up like a book, in that the conferences
correspond to book titles, topics to chapter titles, and
messages to the content of each topic.

An expansion icon (+) to the left of a conference
indicates that the conference contains topics. The
number in parentheses to the right of a conference
name tells how many messages are in it. A 
icon displayed to the right of a conference name
denotes a new/unread message in a conference. To
view the contents of a conference, click on its name.
This action changes the + sign to -, indicating that
the conference is open for viewing, and displays the
list of topics.

The Message Window

If the frames option is turned on, the message
window appears on the right side of the screen. The
messages and the replies are displayed on this part
of the screen. It has a white background (by default).

Topics and Messages

Topics and messages provide the information to the
conferences. A topic is an original message. All the
replies to a topic are considered to be messages.
Also, a message can be an original statement
posing a question or asking for some explanation.
Conferences are made up of threaded messages.

Topics are indented 2 spaces under a conference
heading. A conference may have many topics and
messages under it. All messages in a topic may
have the same name as the original topic or a
different name; however, reply messages are
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indented under a topic message. The topics are
displayed similar to conferences. A plus (+) sign to
the left of a topic indicates there are replies. When
the topic is viewed by clicking on the plus (+) sign,
the sign changes to minus (-).

Clicking on the subject line (instead of the plus sign)
will display all the messages in the message
window.

Reading Messages

Messages are arranged chronologically with the
earliest (original) messages at the top of each topic
list.

Follow these steps to read specific messages:

• From the Conferences list, choose the topic you
want to view and click on the (+) icon.

• Chose the topic you want to read and then click
on its name or on its (+) sign. This displays the
messages under the topic.

• Locate the message you want to read and click
on its name. This displays the message in the
message window. Scroll down if the message
does not fit in the screen.

• When finished, select another message to read
or post a reply.

V. Your Profile
For every user of the WebBoard system, a User
Profile is maintained, which contains some
information about the user. By default your profile
will show your name, email address, location and
statistics of your logins and postings. Whenever you
see a person's name next to a message, clicking on
it will display the user's profile.

You can edit your profile to provide more information
to other users like home page URL, and your
hobbies. The email address and home page URL
are hyperlinks, i.e. clicking on an email address will
open up an email message window or clicking on a
URL will display the Web page. You could also
include your picture or HTML-formatted text in the
hobbies-field as well as in your signature. The

signature you specify here will be attached to all
your WebBoard postings.

An unedited profile will look like this:

Editing your Profile

To edit your profile, click on the  button and
then on Edit your  Profile in the right frame.

In the user profile screen, add the information you
wish to add and then click the Save button at the
end of the screen.

Note that you can change your password here.
After changing it, you will have to re-authenticate to
the system! Also note that although it is possible to
change your login name here, you are NOT
ALLOWED to do so!

The user profile screen after it has been filled in:



5

Changing Your Password

You should change the password the first time you
log in to WebBoard. It is advisable to keep a unique
password, easy to remember, preferably with
reference to something. This way you will never
forget it. Pick a password that has at least five
characters and try to include numbers or symbols,
too. Avoid using obvious choices like login ID, city
name, etc.

Guidelines for Secure Password Selection

Note that you must enter your password twice for
verification. You might want to use the same
password you use for your icarus-account. If you
change one, however, do not forget to change the
other one too. The passwords on each system are
independent of the other.

Note: while it is possible to change your login ID,
you are not allowed to do so. Changing the login ID
causes you to lose access to your previous
messages. Your ID will eventually be changed back
by your instructor anyway. You can correct errors in
your name, but you should notify your instructor of
such changes.

Use Frames: Changing your Display

By default all the users have the frames option on.
WebBoard can be viewed with or without frames.

To turn frames on or off at any time, choose Yes or
No for Use Frames in the Profile window.

When the frames option is turned on, the screen is
split into two frames side-by-side, namely the
Conferences Menu and the Messages window.

When the frames option is turned off, the windows
are displayed one at a time. Clicking on a
conference will display its messages on a new
screen and clicking on a message will display it in
yet another new screen. To get back to the
Conferences Menu, click on its link at the top of the
screen.

Note: Older versions of browsers do not support
frames. In this case, it is advisable to obtain a newer
version of your browser.

Full Topic View: Viewing all Messages

The Full topic view option allows you to change the
way the messages are displayed on the screen.

To turn it on or off at any time, choose Yes or No for

Full topic view in the Profiles window.

When this option is on, related messages in a
conference are displayed one after another in a
threaded manner. This is the suggested way of
viewing the topics.

When turned off, only one message is displayed at a
time on the screen. To view the next message, you
will have to click on the subject line of a message
(when the frames option is on) or click on the Next
link (when the frames option is off).

Mailing list format

This option only matters if your board has any
mailing lists, and if you are subscribed to some. It
controls whether you receive email postings of each
message posted in the respective conference, or
just one email per day containing all of the day’s
postings, preceded by an index. If you select the
Digest/ZIPped option, the actual postings will be
contained in a ZIP archive attached to the message
containing only the index. You will need a MIME-
compliant email-program (such as Eudora, Outlook,
pine) to handle this properly.

Updating the Changes Made

When finished, click on the Save button at the
bottom of the page. If not using frames, go back to
the Conferences Menu to see your changes take
effect.

VI. Participating in Conferences

WebBoard users form a community of people who
share information and ideas electronically. You can
browse through conferences, select topics of
interest, look for new messages, post messages for
all other users, reply to messages directly through
email, and engage in real-time chat sessions. Also,
you can learn about other members of the
WebBoard community and give them information
about yourself.

The list of conferences and the messages in them
are displayed in the Conference Menu as a
combination of purple and blue text either in plain or
italic format.

purple: a visited link

blue: an unvisited link

Note: The colors of links are in general actually
controlled by your browser. Mentioned above are the
default colors of many browsers. The manager of
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your board may have set different colors for your
boards, overriding your browser colors.

A previously read message or a message that has
been marked as read is displayed as plain text. A
message that has never been read since your first
login is displayed in italics. Note that even if you
have marked all messages as read, a message that
has not been read may be displayed in italics
anyway until you Refresh the display.

After you have read the messages in a conference,
you may want to post a new topic or reply to certain
messages. To do so, you can select Post from the
WebBoard menubar or one of several commands
from the little menu above the messages in the
Message window. Notice also that the upper portion
of each Message window contains summary
information indicating the topic and conference
name, number of replies, name and email hyperlinks
to the sender, and date.

The function of each link in the messages window is
described below:

TOP
appears only if you are in Full topic view and it
brings you back to the first message. This option is
not available as a hyperlink if you are already at the
top.

Post
opens a form for posting a new topic to the current
conference.

Reply
opens a form for replying to the same topic as the
current message.

Reply/Quote
opens a new message form, including the body of
the current message and retaining its subject line.

Email Reply
opens up a form with the email address for replying
to the posted message by email. If you have a
private response to someone, send email, rather
than reply to the entire conference. Since this
feature uses your web browser's email capability,
your browser must be set up to send email.
WebBoard itself does not provide email capability.

Delete
Deletes the current message. You can only delete
messages you own because you authored them.

Edit
opens the Message window and displays a message
you have posted for you to edit or modify it.

Previous
displays the previous message from the
Conferences list.

Next
displays the next message from the Conferences
list.

Previous Topic
displays the previous topic and its messages.

Next Topic
displays the next topic and its messages.

Marking Messages as Read

WebBoard has a feature for marking all the
messages that you have read. But it does not do so
automatically. You need to tell WebBoard which
messages are to be marked as read. The two
options are:

• marking all messages in a specific conference
• marking all the messages in all conferences

Marking Messages in One Conference as Read

To mark all the messages in a conference as read,

Click on the  button in the menubar at the top.

A window like the one above will be displayed. Click
on the name of the conference in which you want to
mark all the messages as read. The following
message will be displayed:

All messages in "Conference name" have
been marked as read. 
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Marking Messages in All Conferences as Read

If you want to mark all the messages in all the
conferences as read,

Click on the  button on the top menu.

In the window displayed as shown above, click on
the Mark All Conferences Read link. The message

“All messages in all conferences have been
marked as read.”

will be displayed.

Checking for New Messages

The Welcome screen displayed when you log in will
inform you about any new messages. The list can be
viewed by clicking on the link.

The list of new messages looks exactly like the
conference menu, except for a different background
image. Also, only the new messages are listed, and
only the conferences containing new messages:

VII. Getting Involved

Posting a Topic or Message

When you post to a conference, you are either
adding to a current topic or starting a new topic. If
you want to contribute to a discussion that is
underway, then post a message in an existing topic.
If you have something to contribute to the general
theme of a conference but it doesn't relate to the

existing topic, then you can start a new topic. If you
are the first visitor to a conference, you will also
need to post a new topic message.

Messages can be written as plain text or with HTML-
formatting. Even if a message is written in plain text,
WebBoard converts it into HTML format. This allows
you to include stylized text in your messages. You
can also include inline images and sounds, as well
as JavaScript and Java applets. If a conference has
been set up to allow active links in messages, any
URL typed in a message will be hyperlinked to the
resource listed, without the need to type the HTML
tags.

The steps involved in posting a new topic are:

• Open the conference in which you want to post
a new topic.

• Click on the Post button in the menubar.

• In the message box that appears like the one
below, type a subject for the posting in the field
named Topic.

• Select any of the options available and then go
ahead and type your message. The options
available are described below.

Convert line breaks to HTML breaks
interprets line breaks (hard returns) in the message
as HTML line breaks (i.e. <br>-tags). This is a useful
default option, which allows you some control over
the formatting of your posting.

Preformatted text (No HTML)
to insert, or paste in, original material from another
source, such as an email message. This message
will be displayed as plain text with no HTML
(careful – if your pasted message contains soft
returns instead of hard returns, this option will make
all of your message appear on a single long line!)

Anonymous
to exclude your name from the post. When you use
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this option, your message is signed "Anonymous."
This feature should not be used for class-related
postings, as your contributions to the discussion are
an important part of your grade. Instead, use private
conferences or email the instructor directly to
discuss sensitive issues.

Preview message
to review your message before posting it. When you
choose this option, you can edit it again before
posting. If the Preformatted text option is not
chosen, the message will be displayed as HTML.
This is a good way of testing whether your HTML-
formatting worked. Hyperlinks will be displayed in
color and underlined.

Preview/Spell-check
to use WebBoard's dictionary to check for any
misspelled words. This is a default option. When you
choose this option, you can edit your message to
correct spelling errors before posting. Note that the
spell-checker doesn’t understand HTML codes very
well, so disregard its complaints about those.

Attach file
to attach a file to your message. You can attach the
following file types: Document, Image, Audio,
Multimedia, Application or Unknown. WebBoard's
file attachment option allows document sharing in
work groups. This option actually uploads the file to
the WebBoard server.

To finally post your message, click on the Post
button in the upper right corner of the message
window (you can later still edit or delete your
message, if necessary).

Previewing and/or Spell-Checking
your Messages

If the Preview or the Preview/Spell Check option is
turned on, the message you entered will be
displayed for verification before it is posted to the
conference:

If the spell check option is turned on, the misspelled
words and words not recognized by the spell
checker will be underlined in red. You can click on
the marked words to edit them or use the
suggestions WebBoard offers to correct them. This
window  is displayed:

Select the appropriate suggestion to replace the
wrongly spelled word, or type in the correct spelling
in the Change to: text box and then click the Done
button.

Your instructor can also add the word to the
dictionary, so the spell-checker won’t complain
about it anymore. This is useful for class-related
special terms that pop up frequently in postings.

WebBoard will display the Message Preview
window again. To finally post your message, click on
the Post button.

Editing Your Posted Messages
To edit the messages you have posted,

• Get the posted message by clicking on the
corresponding message subject line in the
Conferences Menu.

• Click on the Edit link in the message header.
• Make changes to the message in the message

window.
• Click on the Post button to post it again.

Including an Image in a Message

Images already present on your Computer can be
included as inline images in your messages. This
can be done after uploading them to the WebBoard
server.

The steps involved in adding images are:

• Select the Attach File option at the top of your
message.

• Type your message.
• Click the Post button.
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A dialog box asking you to type in the name of
the image file to be uploaded will be displayed.
Choose the type of the file you want to upload
by clicking on the appropriate file type in the
choices at the top of the screen. Choose
Image for a graphic file. Select the file on your
desktop with the help of the Browse… button.
If you want, also add a description of the file.

• Click on the Upload Now button.

Now your message will appear with an icon of the
file and the name (and description, if you gave one)
of the file beside it like:

Now we want to include it inline, rather than just as
an attachment at the end. We’ll need to make a
hyperlink to the image:

• If you are using a PC, right click on the image
link (e.g. IMAGE8.GIF) and choose Copy
Shortcut or Copy Link Location from the drop
down menu, depending on your browser and its
version.

• If you are using a Mac, click on the image link
once (e.g. IMAGE8.GIF) and, holding down the
mouse button, choose Copy this Link Location
from the drop down menu.

• Click on the Edit link in the message menu.
WebBoard will redisplay your message in an
editing box.

• In the message, place your cursor at the position
where you want to include your image and then
choose Paste from the browser’s Edit menu, or
hit Control-v (PC) or Command-v (Mac). This
pastes the link location (URL) of the graphic into
your message as shown below:

Inline Images!!<br>
<br>
http://webboard.uic.edu/upload/morph2.gif
<br>
Bill Washington
UIC, Chicago, IL
60607 

• After pasting the location, click on the Post
button. Now you will see that the graphic
appears as an inline image as well as an
attachment.

Note that it is also possible to include a hyperlink to
any GIF or JPEG file on a remote web-server as an
inline image, as you can include any standard HTML
in your postings.

Deleting your Postings

You are allowed to delete the messages you have
posted anytime before. To delete a message you
have posted,

• Click on the message subject line in the
Conferences Menu to display the message.

• Click on the Delete link at the top of the
Message window.

• Select Yes in the verification form posted by
WebBoard.

Replying to a Posting

To post a reply to a message/topic in the
conference,

• Click on the subject line of the message in the
Conferences Menu to display the message you
wish to send a reply to.

• In the Message window, click on Reply or
Reply/Quote in the menu. (Reply/Quote will
include the original message you are replying to,
indented as a quote.)

• Make your selections from the options.
• Compose your reply in the message body.
• Click on the Post button to post the message.

Sending an Email Reply

WebBoard gives you the option of replying to the
author of a message directly instead of to everybody
on the conference. Emailing a reply to the author
can do this. You can use this feature for an
occasional private question to your instructor (about
grades or personal matters). Most questions,
however, should be directed to the class (or your
study group, i.e. probably the members of a private
conference). That way, true class interaction
becomes possible – and you may find that your
questions get answered much faster!

Before you send an Email reply, make sure your
browser mail preferences are configured right. A
desktop mail program like Eudora will also do the
job. If you are working in the UIC public labs or any
other publicly accessible computer, make sure you
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change the mail preferences. You will have to
specify your name and your own email-address for
the From: header of your message, and the
outgoing mail server at UIC must be set to
smtpserv1.cc.uic.edu (if it isn’t already).

In Netscape, you find this under
Edit→Preferences→Mail&Groups→Identity.
In Internet Explorer, it is in View→Internet
Options→Content→Edit Profile→Personal.

Once you are set, follow these steps:

• Click on the subject line of the message in the
Conferences Menu to display the message you
wish to send a reply to.

• Click on the Email Reply link in the message
menu.

• This will automatically open a new message
window - either your browsers' mail program or a
mail program like Eudora - addressed to the
author.

• Compose the body of the message and fill in the
subject line, including your class name. If it is a
question concerning WebBoard itself, please
also include that in the subject line.

• Click Send.

VIII. Chatting in WebBoard
WebBoard's chat lets you create real-time virtual
communities through interactive discussion with
other WebBoard users. Chat lets you exchange
information, questions, issues, and concerns with
fellow users in conference chat rooms. You can also
include images and active links in your chat
messages, if the board manager has enabled this
feature.

To use the Chat feature you must be using a
JavaScript-enabled browser such as Netscape
Navigator 3.0 (or higher) or MSIE 3.0 (or higher).

Each WebBoard conference can have its own chat
room where you can communicate synchronously
with other members of that conference. The course
instructor (board manager) or any moderator of the
conference has the ability to enable/disable the chat
facility for that conference.

Besides the standard JavaScript-based chat facility
traditionally embedded into WebBoard, version 3.0
also provides a Java-based true IRC chat facility
called ConferenceRoom (from WebMaster Inc.).
Only the WebBoard administrator can switch your
board to use this chat server. Due to security gaps, it
is currently not enabled at UIC. This may later

change. A section on this chat facility will then be
added to this guide. For now, curious users may
want to study the online WebBoard help. Note that
for using this chat facility, your browser must also
have Java enabled (besides JavaScript).

Using WebBoard’s Internal Chat Facility:

To enter a chat room, follow these steps:

• From the WebBoard menubar, select Chat. The
Available Chat Rooms list displays all the
available chat rooms and current activity.

• To go into a specific chat room, click the
hyperlinked conference name. The chat window
appears as below.

• To send a message, type your message in the
text box below the menubar.

• Click on the Send button.
• If your message doesn't appear right away, click

on Refresh.

The Chat Window (above) is where you see all the
activity and dialogue in the chat room. The Chat
window has a menubar and a message field where
all messages are displayed. The most recent
message is shown at the top of the list of messages.

The menubar buttons perform the following tasks:

 opens the Compose Message window for
you to type a chat message. You can choose the
color, size and style of the message you send. This
window can be maintained open during the chat
session by moving it in such a way that it does not
cover the Chat window.
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 updates the Chat window. The window
updates automatically every 5 seconds. You can
change the settings on this by entering r=# where #
ranges from 3 to 120 seconds, in the text field. The
letter r can be upper or lower case.

 displays a list of available chat rooms and
their current activity (within the past 15 minutes).
You can enter another chat room by selecting a
room in this window. The Rooms window has its own
menubar, with Refresh and Close. Choose a room
and click on Go To Room.

 displays the list of users currently logged
into the chat room. Also provides a text box for
sending whispers (private messages) to a user, or
group of users (select multiple users with
Control(PC) or Command(Mac) key held down).

The whisper message above is intended for John
Samuel. Click on the Send button once you have
typed in the message.

The recipient of your whisper is notified that this was
a private remark by the whisper… icon in the
message.

Another quick way of whispering to someone active
in the chat room is by clicking on the speech bubble

 beside his name in a previous message he sent.

There you also find the bell icon  for paging him.
Paging the user will let you know if the user is
currently logged on to Chat. It brings up an alert box
on his screen, so if he was doing something else in
the meantime and not paying attention to the chat,
he is alerted that you want to talk to him there.

 logs you out of Chat. Exit Chat using this
button only. (Details below)

 opens up a new Chat Help window.

Adding Smileys

One of the easiest ways to customize your chat
messages is to use smileys. Chat messages from
both the Chat window textbox and the Compose
Message window can contain smileys. You can
enter smileys in chat messages by typing simple text
codes, as shown in this table:

Code Result
:)
:(
:o

Ending Your Chat Session

When you are finished chatting, you should close
the Chat window.

To exit chat, follow these steps:

From the Chat menubar, select Close. A Confirm
Window as shown below pops up.

Click OK. This ends your Chat session.

Remarks

You can be only in one chat room at a time. Thus
you may miss some of the action in the meantime in
another room. If you try to open another chat
window from your browser, it will just switch your
chat room in the chat window that’s already open.
You won’t be able to circumvent this by opening
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another browser program either, as WebBoard’s
database keeps track of users already logged in.

Chatting requires a lot of discipline. If several people
talk about different things at the same time, you’ll
soon be lost. And few people are professional
typists. So be patient and give each other time to
respond! If you are referring to a previous message,
say from Winnie, begin your reply “Winnie, …” or
refer to “What Winnie said…” or use similar quoting
techniques to make the conversation transparent to
your fellow chatters.

In WebBoard’s internal chat facility, everybody is
known to everyone. There are no nicknames and no
anonymous chat. Its purpose is not free expression
of all your world views, but cooperative discussion of
class-related issues. It is an environment to enhance
your productivity, not your entertainment.

IX. Searching in WebBoard
You can search through a particular message or
search for a particular user in WebBoard using the
tools provided.

1. Searching for Users

You can search for users in your board and view
their profiles using the Search Users dialogue. It is
accessible by clicking the  button and then the
option Search Users. Another way to get to this
dialogue is by clicking the  button in the
menubar and selecting the Search Users option at
the top of the frame.

You can search by first or last name, or by just a
partial spelling of a user's name. A list of users with
their first and last names and details (like city, state,
country, and information about their last login) are
displayed for every selection. The first and last
names of the users are hyperlinked to their
WebBoard Profile.

The Search Users dialogue appears like this:

Searching on a User's Last Name:

To search for a user with his last name, click on the
Last Name radio button and type any portion of the
user's last name in the provided text box.

Click on the Search button.

Searching on a User's First Name:

To search for a user with his first name, click on the
First Name radio button and type any portion of the
user's first name in the provided text box.

Click on the Search button.

Searching by First Letter of Last Name:

To search for a user with the first letter of his last
name, in the alphabet presented, click on the first
letter of the user's last name. This will display the list
of all the users whose last names begin with that
letter.

Viewing a List of All Board Users

WebBoard is capable of displaying all the users of
the board. To make WebBoard display the list, click
on the Search button without filling in any search
criteria.

2. Searching Messages

With WebBoard, you can search for messages in
your course's board. The search options available
are
• within a single conference
• in several (or all) conferences
• by a string in the message subject line
• by a string in the message body 

To search for a message or messages, follow these
steps:

Click on the  button on the main menubar.
This will open the Message Search dialogue.
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Choose the conference under which you want to
search.

To select multiple conferences,

• (in the case of a PC) hold down the Control-key
while clicking on the choices of conferences

• (in the case of a Mac) hold down the Command-

key  while clicking on the choices of
conferences.

To select a range (possibly all) of conferences, click
on the first conference you wish to select, then hold
down the Shift-key and click on the last desired
conference.

Select the desired option of the following two :

• Topics only - to search only the topics list, i.e.
the message-titles (subject lines).

• Topics and message bodies - to search also
within the messages

Select the type of Display Detail:

• Standard results
• Detailed results

Detailed results mean that the actual occurrence of
the string is displayed in a short context.

Finally, type the desired word or phrase to search for
in the text box and click the Search button.

WebBoard will display only the first 25 matches (this
number can be configured by the board manager). It
will also show a link to the next 25 matches. This
was introduced to speed up display of the results.

X. Logging Out
To log out of WebBoard, you need to quit your Web
browser. You need to completely Quit or Exit your
browser. This is particularly important if you are
working in a public lab like the ADN.

There you also must log out of the Novell Network

by double-clicking the  icon on the desktop.
Otherwise, others have access to your account and
can destroy your data! Do NOT reboot the computer,
though!

To quit WebBoard, choose

• File and Exit from the Netscape menu.
• File and Close from the MSIE menu.

Or simply click the close box  at the top right
corner of your window.

For Macintosh users, the close box  is at the top

left corner, but this does not actually quit your
browser! It just closes the window. To quit the

browser, type Command-q (hold down  and
type q) or select Quit from the File menu.

XI: Troubleshooting

If you cannot access WebBoard, first try the
following steps:

• Check the address you typed in (or the link you
clicked). It must be of the general form
http://webboard.uic.edu:8080/~yourclassname, with the
class name all in lower case, without spaces.
Thus, if your class were MATH101, the URL
would be http://webboard.uic.edu:8080/~math101.

• If this is your first time logging in to WebBoard,
your password is simply your netID. We cannot
set your password to your icarus/tigger
password. You can do so yourself, once you are
logged in, by editing your profile. If you have
forgotten your password, please ask your
instructor to reset it. If you are on several
boards, note that changing your password on
one of them changes it for all of them!

• Make sure that your browser has cookies
enabled (in Preferences) before logging in.

• Make sure you are using a newer browser, with
JavaScript enabled. Do not use AOL’s internal
browser, unless you have AOL 4.0 software!

If this does not help, contact your instructor and
request a check whether you had been added
properly to the board. You may have been added
with a temporary login name (if you are/were in
another class using WebBoard). You will receive
email notification about being added to WebBoard,
as well as about any changes in the login procedure,
to your UIC email-account (on icarus). If you
normally read email on another machine, simply
forward your UIC email from icarus by putting a file
called .forward into your icarus-home-directory,
which should contain only your other email-address
(yes, the filename begins with a period!).

If you try connecting to WebBoard and the browser
does not prompt you to log in, nor displays the page
stating that such a board does not exist, the server
might be down. Call the Network Operators at
(312) 413-8080 to confirm this and have it re-started.
Tell them what class/board you belong to, and if you
had gotten any error messages, tell them exactly
what those said.

If you have questions about the use of WebBoard
that this user’s guide does not answer, please
contact your instructor.


